CM9001-EMS Programming Manual

Table of Contents

Introduction to0 CM900T-EMS......ciiiiniiiienssiinsnnsseinsnecsssncsnisssisssesssssssssssssssssssssssssssssssssssssssssssss 2
K@Y FRALUTES. ..ottt ettt et e et e et e ettt e e bt e e e e e s e abaeeeeeenans 2
Part NUIMDETS. ......eeuiieiietiete ettt ettt ettt e bt et s et et e enbe e st e sbeesabeesnbeeenteeenseeens 2

CMO00T-EMS INStallation.......eeeueieiieiieeiieeie ettt ettt ettt et sttt e st e e st eeennaeeens 3

Programming........ccccceecnseecssnnccssnncssssrcssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssss 4

USING COMIEIGUIALOT . ......eiuiiiiiiieiierit ettt ettt ettt sbe et e bt sbe et s e e nbteesaaeeeaeees 4
L0Ad TOMPIALE. ... .eevieiiieiieeiie ettt ettt ettt e ebe e ettt e teeesbeesbeeesseessaeessaenseassseenseeensaessaeenns 4
Connecting to CM9001-EMS for Programming...........c..cccceeuerieneriienienenieneeieseeneeee e 4
Scan fOr MOAUIES. .....c.eiiiiiiieeee ettt st sttt e e s es 7
ZIOMES/INPULS. ...ttt ettt ettt e et et e et e et eesabeebeesabeenbeeenbeenbeesnseenseeenseeaea 9
Y03 1 TSl 7 01T PSPPSR 10
F N 011 T ) o1 OSSPSR PPPR 11
PhONE NUIMDETS. ..ottt sttt ettt ettt e bt et esat et e b e snteesnteesnneenas 13
SMS REPEAL TIME.....cuveiuieiiiiietieiteeteee ettt sttt sttt et e be e e nbaeesaaeesaeees 14

70N AULO-SHUNE COUNL.......eiiiiiiiiiiiiiieetee ettt sttt 14

SMS ReGUIAT TESEINE......eeruteiieitieiiiriieteeit ettt ettt et et ettt sete e st e saneesanees 14
CMO001 Sensors FUNCHION. ......coiuiiiiiiiieiiieiteete ettt et s e e s 15
(010101 1115 1SR OO PUOUP PR OPPTRPPRP 16

FLagS. ettt ettt e et e ettt e et e e ab e e e at e e e e e nabaaae e e e nnraaeens 16

VATTUAL INPUL. ..t ettt e et e et e e et e e enbeeeenaeeas 16
ProCESSING Of SENSOTS...cuuiiiiiiieiiiie ettt et et e st e e st e e ssbeeesaeeesaeeensaeeansnees 18
MSMO1 Programming.......c.ceeecsseesseecsensssesssesssansssassssssssnssssssssasssssssssssssssssasssssssssassssssasssssssssssssases 19
Detection of Water Leakage Cable Break...........cc.oevvieiiiniiiiieniieiieieeiee e 26

KPO4AE in EMS MOde......uuuiiinniiinsiicssnnicssnnessssnissssnessssessssscssssssssssssssssssssssssssssssssssssssssssssassssssssses 28
KPO4AE/KPO4AET Operation (EMS MoOd@)........cccueeiuieriiiiieiieeieeiie et sve e eaee e 32

CONIIOL MM U..cuuueiiiieriiiinricssnricsssnncssseesssnessssnessssnessssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssasssses 35

iOS/Android Apps 36

SIMS MONIEOTING..cerueerseessrenssnnssresssnnsssecsnesssesssnsssassssasssssssssssssssssassssssssssssassssassssassssassssssassssssassssanases 37

Graphical Sensor DiSPIaY........cceicinricnssercsssnncsseicsssnsssssnsssssssssssssssssssssssssssssssssasssssssssssssssssssssassssss 40

DOCUMENE HISTOTY .. ..eeiiiiiiieiie ettt ettt et e sb e et e et e et e e sbee e st e e saeesateeeannees 40



CM9001-EMS Programming Manual

INTRODUCTION TO CM9001-EMS

CM9001-EMS is an Industrial / Environmental Monitoring System for monitoring of
external inputs and Sensor Data for unattended facilities like Data Centres, Server
rooms, Wine chillers, Telecoms Base Stations, and Pharmaceutical Freezers.
Notification of alarm is via dial out to phone numbers for Voice announcements and
SMS messages. This manual shows how to program and operate the product. The
CM9001-EMS Installation Guide has installation instructions for the product. Please
download the latest verS|on of the manuals from

Key Features

8 Inputs, 8 Outputs expandable to 96 Inputs, 96 outputs

31 Alarm Types (Temperature, UPS, Humidity able to dial to any combination of 16
phone numbers including Voice Phone for alarm anouncements and SMS (requires
UCM/GSM4).

With the UCM/GSM4, SMS can be programmed to resend at regular intervals until
the alarm is disarmed or the alarm input has been restored. SMS messages can also
show the Temperature, Humidity or other Sensor value beoing Monitored.

Outputs can be programmed to control equipment

Time Programs or schedules can be programmed to control equipment or change
monitoring modes or to send out regular SMS test messages.

Up to 15 Keypads can be installed to disarm (silence) the alarm, to monitor
temperature, humidity and other sensors, to control equipment, to test the state of
the input alarms, and to make changes in the program.

Cytech mobile apps can be used to monitor the alarms and do control

Supporting modules eg MSMO01 MultiSensor Module, TSM01 Temperature Sensor
Module, and IRIO provide temperature and other sensor readings and setpoints
which activate temperature and sensor alarms. UCM/Pi allows Graphical display of
Sensor values and automatic daily email of sensor values in .csv format

Part Numbers

CM9001-EMS PCB with terminal blocks, End-of-line Resistors, battery cable.
Min firmware 7.160

ENO1D: Metal Enclosure 310 x 350 x 95 mm with Power Supply (Input 90-
260 VAC, Output 15VDC 1.6 Amps). Ordered separately.

KPO4AE EMS Keypad (min Firmware 7.014). Display sensor and setpoints.
Announces alarm and zone activations, with siren sounds. Up to 15 Keypads
in a system. Min Firmware 7.014

KPO4AET EMS Keypad with Built-in Temperature Sensor.

ETHO3 Ethernet Plug in module: for programming by Comfigurator and
access by mobile Cytech Comfort app.

LEMO02B: 8 Input expansion, direct plug in to CM9001-EMS or SEM01C
SEMO01C: Slave Expansion Module with 8 Inputs, 0 Outputs. Up to 5 SEMs in
a system. OP03 Output submodule with 8 outputs and LEM02B Local
expansion module with 8 inputs can plugged in directly on SEM01C PCB.
MSMO01: Multi-Sensor Module with built-in Temperature, Humidity and Water
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Leakage Sensors, with 4 external Inputs. Min Firmware 7.004 Up to 15
MSMs/TSMs in a system

« TSMO01: Temperature Sensor Module with external Thermistor sensor. Up to
15 TSMs and MSMs in a system.

« UCM/Pi - Raspberry Pi interface allows Grphiical display of sensors and daily
email of sensor values in .csv format

+ IRIOO01 Input/Output Module with ISM01 submodule with 4 external
Thermistor sensors.

« UCM/USB: USB Interface for programming CM9001-EMS

CM9001-EMS Installation

Please refer to the CM9001-EMS Manual for Installation instructions . Download from
http://www.cytech.biz/product details.php?item 1d=505

A typical installation of CM9001-EMS is shown below.

CM9001-EMS, UCM/GSM4 GSM Module, LEM02B expansion (optional) and the 12V 7 AH sealed lead
acid battery can fit in the ENO1 enclosure (310 x 350 x 95 mm)

1 or more KP04A keypads (max 15), and 1 or more MSMO1 (max 15) can be installed.

Note that MSMO1 is not needed if Sensor monitoring is not required..

RS485 BUS
(Y]

_lf_ UCM/GSM Battery MULTI SENSOR
) B | gl MULTI SENSOR
(C_ 1 hMOOP g - = DULE
QROO MULTI SENSOR

MODULE
olelele
oco0oo0000

KPO4A |HH ‘ |HH | l L \_)

8 digital 8 digital Temp Humidity Water leak
inputs outputs Sensor  sensor cable


http://www.cytech.biz/product_details.php?item_id=505
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PROGRAMMING

Using Comfigurator

Use the Comfigurator software version 3.12.15 or above to configure CM9001-EMS. The software can
be downloaded from http://www.cytech.biz/comfigurator.html

The plug in ETHO3, or alternatively a UCM/USB or UCM/Ethernet is required to connect to the
computer running Comfigurator.

Load Template

Run Comfigurator, go to File > New, and select EMS from the drop-down list.

Select Template L&J

Select the template to use as the basis for the new configuration.

Default Template [ EMS -

Comfart 1| ULTRA
Comfort [l Optimum

oK Logic Engine
- Comfort Il SPC

SMSWatch —
P Comfort | PRO (Obsolete) 'F_"
16 Zonelb Comfort | ENTRY (Obsolete)
17 Zonel7 Comfort | ULTRA {Obsolete)

KS

12 Zoneld UCM/Logic
19 Zone19 Ews
This loads the default EMS template. To set EMS as the default template so you can select by default in
Comfigurator so to Options Menu > Default Comfort template and select EMS in the same way.

Also go to File > Update Defaults in order to update certain templates and default settings from the
Cytech Server via the Internet. You will be asked to restart Comfigurator in order to apply the new
defaults.

If MSMO1 MultiSensor Module is to be used in the system, load template defmsm.cctx instead using
“Browse for Template Files” (see section on MSMO1 later)

You can start to program the system without being connected to the CM9001. If CM9001 is connected,
see instructions in the next section.

Connecting to CM9001-EMS for Programming

CM9001-EMS can be programmed with the following hardware;

« ETHO3 Submodule plug-in on CM9001-EMS PCB

« UCM/ETHO3 with ethernet interface or UCM/USB with USB Interface
If the ETHO3 submodule is plugged in to CM9001, connect an Ethernet cable
between the ETHO3 and a switch or router.
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ETHO3 Submodule (Plug on CM9001 ETH J1 header)

If the ETHO3 submodule is not installed, a separate UCM/ETHO3 or UCM/USB can
be used instead to connect by USB to a PC or via the LAN respectively.

The following describes how to set up ETHO3 submodule directly plugged in to
CM9001 or by another UCM/ETHO3 (connection by Ethernet) or UCM/USB
(connection by USB). In Comfigurator, go to Options, Settlngs

settings .._._, v
= General ,'_.l
Auto-Recovery Save Interval | 5 |__T
Optimize Responses | ] M 10
Open Last File On Startup | False & ‘E
Remember Sign-In False | B I
Show Splash Screen False i
Backup Before Write True [
| UCHM Connection |
LICM Interface | Network (Local)
Metwork Address {Local) | 192.168.1.204
Metwork Port {Local) 1002

" Comfort Server Maﬁ@er (ETHO3)
DS Manager (ETHO1/02)

(3] Crid Cime l Serial

UCH Interface

Interface between PC and UCM. If connecting using the Serial Port, select the port number to be used. If connecting
via the network, select the IP address and port number of the UCM. If connecting via USB, select the serial number of
the USB LICM,

[ oK | [ cancel |

Select Network (Local) for connection by ethernet, USB for connection for
USB.Network Connection (ETHO3)

For ETHO3, click on Comfort Server Manager (highlighted above)
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(& Comfort Server Manager

[ Refresh | [ Gear List | | Beboot SNTP Setting | Email Setting | DHCP (oSt ]
New IP: 192 162 1 204

IP Address Host Name MAC Address Version Portl Port2 DHCP Gateway: 152 168 1 1

192.168.1.204 COMFORT 40-D8-55-0F-E0-21 Bh3GEv¥2.23 idle idle no Subnet- 255 255 255 0O
DNS: 192 1868 1 1

Transport Protocol TCP

Routing Mode: Server

Port1: 1001

Timeout 1: 0z
‘ m ) Port2: 1002

Timeout 2: 0z

Target IP: 0 0 0 0
IM Target Port - 1001

20ms

UCM/ETHO3 manual Version: 2.1.0 16/03/2017  Cytech Technology Pte Lid Upgrade Lk N e || COMPORT

DHCP Box: check this box to automatically assign the IP address via your routers
DHCP. Leave unchecked for Fixed IP address

Id DHCP is unchecked, fill in the following fields;

“New IP”: Enter IP address of the ETHO3

“Gateway” Enter IP address of gateway (router) if remote access is required
“Subnet”: enter Subnet of the IP address

“"DNS"” Enter IP address of DNS server if required. (Not required for local access)
“Port 1”: enter 1 port eg 1001

“Port 2”: enter 2" port eg 1002.

ETHO3 allows 2 ports to access at the same time

“Timeout” enter time out in minutes for ETHO3 to dicsonnect if the connection is
idle. 0 means No time out

“Host Name” : Descriptive text of ETHO3

Press the SUBMIT button to confirm. Warning message appears as below.

warning

Changing the IP address and Port may affect your network connection
l % to Comfort if not done correctly. Continue?

| oK | | Cancel |

Press OK to confirm. The CS Manager window will become blank
Press the "REFRESH button. This will cause the new parameters to display.

For UCM/USB, after plugging in the USB cable to the PC USB port, in Options >
Settings/ UCM Interface, select USB and select the USB Serial Number from the
Drop-down list.
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g ™
Settings ‘ M
= General -
Auto-Recovery Save Interval | 5 i
Optimize Responses ] Ma 3
Open Last File On Startup False
Remember Sign-In False B
Show Splash Screen False

1=/ WCM Connection
IICM Interface ISE
Serial Number ATOOTIP [

Scan For USE Devices

- Graphical Editing

Grid Size 8,8

Snap To Grid False
= Toolbar -
Serial Number

The serial number of the USE LICM,

| oK | | canca | |

Scan for Modules
File Edit View Transfer Options Tools Help

MEEHSQ ¥ B '@ QO 3 WO = sk

Comfort | Modules | E S troller
B [Coroi L
.03 UCMs |  ScanFor All Modules I
- | | EnviroMonitor
i B Write Modules & Settings to Comfort 17
= Keypads Check for Firmware Upgrades | 7.138
by Mot available
h' Download Firmware Upgrade ot ; s
- DoorSta Unassigned
I Slaves Upgrade Firmware from Local File 15
-7 Sensors || | | Custom Vocabulary | False
- SCS/RINARIN= Custam Wneshaolane Warsiam | AN

If CM9001-EMS is connected, go to the Modules Tab and right-click on Controller as
shown below.

Select "Scan for All Modules”. This will automatically detect the CM9001, and all
modules which are installed in the system provided the ID of modules are set
correctly without any conflict. The login window appears (if you have not logged in
previously).

Lagin ﬁ1

Enter User Sign-In Code:

Enter any of the user codes, default is 1234 and press OK
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(“z emstest - Comfigurator (Engineer Made) = = ]

File Edit View Transfer Options Tools Help
NEHSL s B9 @ Q0 1 w0 HstE

S e W

...... . Cortraller
=3 UCMs
_____ . UCM Mame EnviroMonitor
L] vemoz Comfort FileSystem 37
B3 Keypads Comfort Version 7.138
e l KeypadO1 Latest Version 7138
--1_J DoorStations Serial Mumber Unassigned
-1 Slaves Vocabulary Mumber 15
17 Sensors Custom Vocabulany False
{4 SCS/RIO/IRIOs System Vocabulary Version | 40
~{d HIOs Uszer Yocabulary Version 1
LCD Teat Version 2
LCD KP Min Version 3
L Manual

The screen after scanning shows CM9001-EMS firmware as well as other UCMs
(KNX or Cbus), MSM, TSM, Keypads installed in the system.
The Menu bar shows the operations;
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File Edit View | Transfer | Options Tools Help
- Write (PC->Comfort)... [
Write Selective...
= Configuration Read (Comfort->PC)... ,
2] General Inf tion
&5 System Infg Read Selective...
h[ Modules ar
tb Woice Setti
5‘; IR Transmit Event Log
i Tuning Pan Reset System
- Alams
- J Telecoms Set Comfort Date/Time
-3 Control )
EH-{ 4 Comfort Registe @ System Information...
[#-{_J Events
&L Schedule Vocab Upgrade ...
[#-{_3 Functions
< il | Sentence Tables Upgrade ...
UCH I/0 Monitor | () and:
Firmware Upgrade ... 3
Message D5P Firmware Upgrade
< 0K
> DLeSDe4000060018000e001E00060018000€00180006001E80008

Transfer > Write (PC to Comfort) : transfer the program to CM9001-EMS

Transfer > Write Selective : transfer the items that have been modified to CM9001-
EMS

Read (Comfort to to PC): Read from CM9001 to PC

Read Selective: Read selected items from CM9001 to PC

File > Save to Save the cclx file.

File > Load to Load a cclx file

Zones/Inputs

File Edit View Transfer Options Tools Help

BY=1" IZ IR X © Q0 3 HOESIELZE™M Qa8

Comfort | Modules | Znnes’[lnput_s g
-3 Corfiguration - = =
=3 Alams 3 Mo Name Zone Type Phrase =l = 'l?""e Properties
a} '|
[ Zones/Inputs 1 UPSIFal  _24HGroupINO[1] UPS 1 Failure = F]“mber s
%] Zone Types 2 AirconFailure  _24HGroup1NO [1]  Airconditioner Failure — ame T =
- ¥, Non-Detector 1 CRAC 24HGroupTNO [1]  CRAC Zone Type | _24HrGroup TNO
d} Nam Types |2|/| | 4 FM200 _24HGroup NG (1] FM200 g”e #’E ; . 1'-'F'5
L gfn"” r‘jﬂd';s 5 Chilerlam  _24HGroupINO [1]  Chiller Alamm e
- %4 Phone Numben ne Woi ailure
- fl Aming and Disi 5 [ Zoeft ke MO Zone Word 4
7 Zonel7 _24HrGroup 1NO [1] R
-] s Ouputs )| | 0 5 24HGroup TNO [1] e
.E. Miscellangous ! 5 S = P On Response | MullResponse
""{19 C?nﬁgumtlnn A 10 Zons1D Off Response | MullResponse
~Hf Siren Types 1 Zonell Show Status | [7] Mo
Eg g?ﬂugd Types = 20”812 Duplicate EC
ne
-EM5 CMS Formats 13 Zoneld
-4 Telecoms o 14 Zoneld i
5 I;_.—..r"_:—. T 1:l Fee1LC

CM9001-EMS has 8 Zones/Inputs which can be expanded to 96 by adding LEMs and
9
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Slaves (SEM01C). The Zones/Inputs screen is for selecting what each Input (also
called Zone) in CM9001-EMS is connected to. Default Zones 1 to 6 are pre-
programmed as shown above.

“Name”: Enter the text describing the Input, which will appear in the SMS
message eg “UPS Fail”, "Temperature” etc. The Name is not announced on
the keypad. Zone Words (see below) are announced.

“Zone Type”: select a Zone Type. Zone Types are pre-programmmed
characterics of the input, eg Bormallly Closed, Normally Open, 24 Hour. Each
Zone Type is linked to an Alarm Type. The most common Zone Type is
“_24HrGroup1NO” which is Normally Open, 24 Hours, Group 1 Alarm.

“Zone Words” 1 to 4. These are 4 words that are announced on the keypad or
telephone (during dial out) to describe the active zone. If left blank the Zone
Number is announced on the keypad/ telephone when in alarm, eg “Zone 1”
“Virtual Input”: this box is checked automaticaly if the Input is Virtual, ie it is
triggered by an external device like TSM temperature sensor, or 3™ party
systems like KNX and C-Bus. If the box has a check mark, the physical input
connected to the Zone/Input is ignored. This cannot be changed by the user.
More on this later.

"“On Response”: You can select or program a Response or program to be
triggered when this input is activated eg control outputs or other devices.
This is optional - leave unselected for now.

“Off Response”: You can select or program a Response or program to be
triggered when this input is restored eg control outputs or other devices.
This is optional - leave unselected for now.

“Show Status”: Check the box to show the real time state of the Inputs (as
"On” - active, or “"Off” - inactive. The system mist be connected to use this
feature.

“Duplicate EOL": This is related to the End-of-Line option to be discussed
later.

To get started, it is enough to just enter the Name and Zone Type of each input in
use. Other fields are optional.

Zone Types

Zone Types are properties assigned to each Zone. The Properties of Zone Types
should normally not be altered. If a special Zone Type not in the defaults list is
needed, the “unused” Zone Types from 26 to 31 can be changed.The list of Zone
Types are shown below.

10
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Comfort | Modules |

+-{_J Configuration

53 Alarms

@ Zones/Inputs

----- Ely Zone Types

----- 1. Non-Detector Alam
- Mam Types

----- & Sign-In Codes

----- 24 Phone Mumbers
----- &l Aming and Disarmi
ﬂ Status Outputs
-ﬂ- Miscellaneous Sett
----- 7| Configuration Flags
i Siren Types

----- : i Sound Types

..... ® CMS

-LM5 CMS Formats

-4 Telecoms

-4 Control

-{_J Comfort Registers

e[+ [F] e [F

1
L
)
&

ﬁ Miscellaneous Eve
=h X110 Receive Code
3% IR Receive Codes
Room Responses
----- SCS/RI0 Respons
-4 Schedule

-4 Functions

¥

Zone Types ﬂ
Mo  Mame Sec. Off Py Night Da * ||'5 Zone Type Properties
1 _24HrGroup TNO Immediate  Immediate  Immediate  Imn Rt s 1
2 _24HriGroup 1NC Immediate  Immediate  Immediate  Imn Name. _24Hrf.3n:|up'| NO
3 _24HrGroupZMO Immediate  Immediate  Immediate  Imn CEa Immedfate
4 _24HrGroup2MC Immediate  Immediate  Immediate  Imn A-r-.'ag,r Immed!ate
5 _24HriGroup N0 Immediate  Immediate  Immediate  Imn Mgkt Immed!ate
& _24HrGroup3MC Immediate  Immediate  Immediate  Imn Day immediate
7 _24HriGroup4MNO Immediate  Immediate  Immediate  Imn Eila = No
g _24HrGroupdMC Immediate  Immediate  Immediate  Imn ;l:n::ﬂr LT :Zs
G _24HriGroup5MNO Immediate  Immediate  Immediate  Imn Digial No
10 _24HrGroup5NC Immediate  Immediate  Immediate  Imn Sensiiviy 100
11 _AmedGroup1MNO  Disabled Immediate  Immediate  Imn
12 _AmedGroup1NC  Disabled Immediate  Immediate  Imn| S il inclll| _AomCro.g |
13 _AmedGroupZM0  Disabled Immediate  Immediate  Imn i lwitey Zone Trouble
14 _AmedGroup2MNC  Disabled Immediate  Immediate  Imn
15 _AmedGroup3NO  Disabled Immediate  Immediate  Imn
16 _AmedGroup4MNO  Disabled Immediate  Immediate  Imn
7 _AmedGroupbNO  Disabled Immediate  Immediate  Imn
18  Temperature Immediate  Immediate  Immediate  Imn
15  Humidity Immediate  Immediate  Immediate  Imn
20 WaterLeak Immediate  Immediate  Immediate  Imn
21 SwitchNO Disabled Disabled Disabled Dis
22 MonitorMNO Immediate  Immediate  Immediate  Imn
23 FireNO Immediate  Immediate  Immediate  Imn
24 GasNO Immediate  Immediate  Immediate  Imn
25 SwitchNC Dizabled Dizabled Dizabled Dig
26 EntryDoor Disabled Immediate  Immediate  Imn
7 DoorWindow Dizabled Immediate  Immediate  Imn
28 ZoneTypeld Immediate  Immediate  Immediate  Imn T

It is suggested that Zone Types 1 to 10 are used to assign to External Inputs.
These zone types are 24 hour, ie active at all times. Zone Types 11 to 16 are
disabled in the Security Off Mode ie when the system is disarmed by entering the
user code on the keypad - the system has to be armed by pressing the Away,

Night or Day key.

*+ “"Name” eg “24HrGroup1NO” is a decriptive text of the Zone Type. The Name

is selected in Zones when choosing a Zone Type for the Zone/Input.

« "“Security Off”: select from Disabled, Immediate, Alert, or Perimeter state
when this zone type is active in Security Off mode. Select Immediate or
Disabled only. Alert and Perimeter are not used for EMS. See note below

+ “Away”: select from Disabled, Immediate, Alert, or Perimeter state when this
zone type is active in Away Mode. Select Immediate or Disabled only. Alert
and Perimeter are not used for EMS.See note below

* “Night”: select from Disabled, Immediate, Alert, or Perimeter state when this
zone type is active in Night mode. Select Immediate or Disabled only. Alert
and Perimeter are not used for EMS.See note below

+ "“Day”: select from Disabled, Immediate, Alert, or Perimeter state when this
zone type is active in Day mode. Select Immediate or Disabled only. Alert
and Perimeter are not used for EMS.See note below

 “Entry Door”: Leave unchecked. Entry Door is not used in EMS

* “Normally Open”: check if the zone is Normally Open, uncheck for Normally
Closed. A Normally Open zone/input is inactive when the Input is open, and

11
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Active when the Input is closed, and vice versa.

+ %24 Hr”: leave this unchecked. This is not normally used.

+ "“Digital”: leave unchecked. This is not normally used.

+ "“Sensitivity”: this is the mininum duration in milliseconds that an Input/zone
must be active in order to be considered activated to the ON state. From 10
ms to 850 ms.

+ “Alarm Type (Normal)”: This is the Alarm that is triggered when the Input
changes to the ON state.

« “Alarm Type (Trouble)”: This is the Alarm that is triggered when the Input
changes to the Trouble state. This should only occur if the Zone is set to EOL
(In the Zones/Input Screen), End Of Line resistors are used and the wires
from the zone contact are cut. If the zone is not EOL, then Zone Trouble
should not occur unless an external voltage is applied to the Input (which is
not allowed - only voltage-free open/close contacts should be connected).

Note on Security Modes

It is possible to arm the EMS to Away, Night, or Day modes like a burglar alarm
system. This feature is usually not required in EMS but it can be used for systems
that are combined alarm and monitoring.

Alarm Types

31 Alarm Types determine the Alarm behaviour of CM9001-EMS.
Each Zone Type is linked to an Alarm Type, for example Zone Type 1
“24HrGroup1NO” triggers *_AlarmGroup1l1”.

("3 Untitled - Comfigurator (EMS Mode) =R * ]
File Edit View Transfer Options Tools  Help
=T 9 o A = -
RE=1" = I LA s §OEHEE ¢
Cormfort E
QT |I'U'Iudules| Alarm TFDES =
#-[_d Configuration -
-0 Alams Mo  Name D/0ut  Dial Indexes + |/~ Alam Type Properties
B Zones/Inpus 1 _AamGoupl Yes 12345678 == P
i _ Types 2 AlarmGroup2 ez 1234 e SRR
P - T i vy
""" 3 Phone Numbers || | 3 pamGroup? Yes 5678 gfa: ?;’t Tes
G- gﬁm' e 4 MamGroupd  Yes 9101112 '3l Indexes )
Eij—-‘ = r:“ sgisters 5 _AamGroup5  Yes 13141516 ;
EEI---:_JJ S;:edsule 6 | linclut No 4
7 LowBattery Yes 123456789 = 5
g PowerFail fes 12345672859 &
5 Emergency Yes 1.2345678591011,1213," -
10 Unused10 Mo 1234567859 é
11 Tamper es 12345678510111213." s
12 Fire Yes 1.234567.8.59.1011,1213," 10
13 Gas Yes 1.234567.8.591011,1213," GRE
14 ZoneTrouble fes 1234 12
15  Temperature Yes 12345678 13
16 Bypassfone Mo 14
7 SystemDisamed  Yes 115
18 CMSTest Yes 1.2 B 16
19 5 Amed M
20 ;_:Eani-: < NZ Responze Mame | MullResponsze
21 UnusedType2l  No Alamm Phrase WARNING ALA...
e T P & Strobe Yes

The parameters are;
12
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“Name”: The name of the Alarm Type. This is the text of the Alarm in the SMS
message

“Dial out”: Check the box if this alarm should do a Dial out to the selected phones.
“Dial Indexes” 1 to 16: check the box if this alarm should dial to this Phone index.
Any combination of 16 phones can be selected for each alarm. See Phone Numbers
section below for details.

“"Response Name”: Enter a Response (or program) which is activated by the Alarm.
This can be to control outputs or other facilities.

“Alarm Phrase”: This is a voice announcement on the keypad or telephone which is
selected from a drop-down list. This is NOT the text of the alarm SMS message.
“Strobe”: this determines if the dedicated Strobe Output should be turned on when
this alarm occurs.

“Siren Type Name” This is the Siren Type that is activated by this alarm. A 12 siren
or sounder may be connected to the SRN-/SRN+ terminals if required.

-
Settings I,&J
- General
Auto-Recovery Save Interval | 5
Optimize Responses Mo )
Open Last File On Startup False 5
Remember Sign-In False
Show Splash Screen False
Backup Before Write True
= UCHM Connection
IJCM Interface LISB
Serial Mumnber A402PBB4
Scan For USE Devices
- Graphical Editing
+ Grid Size 8,8
Snap To Grid False
= Toolbar
a General Information Mo
h} Modules and Settings Mo -
[ 0K | | cance |

Phone Numbers

CM9001-EMS is able to dial to 16 phone numbers, selectable for the following
Phone Types;
*+ SMS: Send SMS to the mobile phone. UCM/GSM4 must be installed to see
this option
* Voice Phone: ie any phone number to announce the alarm and zone by voice.
+ CMS, or Central Monitoring Station. This is normally for Burglar alarm
systems to call police response. This option is limited to the 1% 2 phone
numbers. If not used, the 2 phones can be used for other phone types.

13
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File Edit View Transfer Options Tools Help

B 1=7" [= Ir-\ 000 s HOEE ¥
Corfot [Medes|  phone Numbers

+-[_J Configuration -

=-3 Mams No  Mame Phone Type  Phone Number =/ Phone Number Properties

- ) Zones/inputs 1 PhoneNoD1 SMS 53614013 umber 1

Alam Types 2  PhoneMo02 Mone hame PhoneMo01

i 5 Phone Numbers 3 PhoneMo03  Mone AL SMS

+|_J Contral 4 PhoneNoDd  None Phone Mumber | 53614013

+'—J Comfort Registers h PhoneMo05 Mone 5 L=

+'—J Events B PhoneMoD&  Mone Keypad Keypadll

+-_d Schedule 7 PhoneNoD7  None Initizte Dial Test
8 PhoneMo08  Mone
5  PhoneMNo03 SMS 56674633
10 PhoneMo10  Mone 53614013
11 PhoneMNe11l  Woice 56674683
12 PhoneMo12  MNone
13 PhoneMNel13  MNone
14 PhoneMNol4  MNone
15 PhoneMNol1%  MNone
16 PhoneMNol6 SMS 53614013

The 16 phone numbers correspond to the 16 Phone indexes in the Alarm Types.

Dial Test: This button starts a dial out to all the phone nunbers that are
programmed. If a keypad is installed in the system the dial tones and call progress
can be heard on the keypad. This is a good way to test that the dial out to all the
phones are working.

SMS Repeat Time

Comfort | Modues | , Security Miscellaneous Settin

+-{_J Configuration -

-._J Marms - Migcellanecus Settings
E Zones/Inputs Battery Test Interval fhours) 24
..... By Zone Types Battery Test Duration (minutes) | 2
..... 1. Non-Detector Alams Zone Auto-Shunt Court 21
‘E Alam Types = Alert Time (minutes) 10
----- & Sign-In Codes Line Cut Timer (seconds) &0
----- 23 Phone Mumbers Siren Delay {minutes) 10
----- k] Aming and Disaming SMS Repeat Time 2
ﬂ Status Outputs
ﬂ- Mizcellaneous Settings
----- | Corfiguration Flags

Miscellaneous Alarms > SMS Repeat Time is the time in minutes (0 to 120 minutes)
to repeat SMS Messages for the Alarm. CM9001 will resend SMS at the specified
interval UNTIL the zone/input causing the alarm has been restored, or the alarm
has been disarmed using the Keypad or phone menu. Setting SMS Repeat Time to
0 will disable the repeating SMS.

Zone Auto-Shunt Count

This is the number of succcessive activations of the same Input after which the
Input will be de-activated and will not trigger the alarm again, until another Input
is triggered. This prevents too many dial outs caused by a faulty Input.

14
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SMS Regular Testing
It is recommended to perform an automatic SMS to programmed phones every

day, in case there are problems with the SMS or the SIM card. Go to Schedule >
Time Programs

omfort | Modules

Time Programs

-3 Configuration

L:.l._J Alamms MNo  Mame Response Time Days * - Time Program Properties
~fg Zones/inputs || | 1 TimeProgram0l  AutoAmNightFrom  23:00  Mon, T Humber :
""" By Zone Types 2 TimeProgam02 AutoAmNightFrom 00:00 Mon, T Name TimeProgram(l5
..... . i. Non-Detector / 3 TimeProgram03  AutoDisarmFromNi  08:00 Responzse Name | CMSDial Test
- }-‘-.!arrn Types TimeProgram04  AutoDisammFromMi  00:00 Time 11: 00
4 Srotie | | T | " e
_____ Q Amning and Dis G TimeProgram06  MullResponse 00:00 Wed
ﬂ Status Outputs 7 TimeProgram07  MullResponse 00:00 Thu
% Wiscellaneous &  TimeProgram08 MNullResponse 00:00 i
_____ =71 Configuration F i) TimeProgram(®  MullResponse 0000 = oot
Uﬁ Siren Types 10 TimeProgram10  MullResponse 00:00 S
..... : i Sound Types 11 TimeProgram11  MullResponse 00:00 Hol
..... B CMS 12 TimeProgam12 MullResponse 00:00 Enabled B No
M5 CMS Formats 13  TimeProgram13 MullResponse 00:00

Select Time program 5 which is default programmed for CMS Dial Test. The days of
week are set to all days, and time to 11:00 AM. Bby default, the Enable setting is
OFF. To enable it set Enable to ON. This will use the Alarm Type “"CMS Test” to dial
to the programmed Phones by SMS or voice call.

CM9001 Sensors Function
Comfort | Modules |

¢

Sensor Responses

F-{d Corfiguration
B0 Aams No  Mame Response Setpoint Counter Name ~ Max Setpo * ||~ Sensor Response Pmpertle:
m Zones/Inputs 0 SensorlD NullResponse  CounterD00 99 :\jumbﬁr S 00
~-B) Zone Types 1 SensOi-Templ NulResponse _CirOD1-Templ 0 Hame . NE'ED
- ¥, Non-Detector Alam| | | 5 5ensD2 Humidl  NullResponse _Cir002-Humid1 39 ffp‘?”ff E'rt"e | TR
d} ';‘_a””IT‘EpEdS 3 Sens03Water] MulResponse _CirDD3-Water] 120 ;;1&3!:'1& E;“:rt‘r N'j a—
& Slan-in Lodes 4 SensDd-Water2 MNulResponse _Cir0D4-Water2 120 PO Loumer Tame | -ourTe
-3 Phone Numbers Max Setpoint 39
) - 5 Senzorl5 NullResponse  CounterD0% 59 ; -
- Aming and Disami Min Setpoirt 0
& Sensor(E NulResponse  CounterDDE& 59 :
ﬂ Status Outputs - - - Hysteresis 1
ﬂ' Miscellaneous Seft 7 Senzorl)7 NullResponse  Counter(7 59 Calibration 0
{7 Configuration Flags 8  Sens08Temp2  NulResponse 39 Sealing Type None
-l Siren Types 9  Sens(S-HumidZ NullResponse 35
o ¥p Scale Factor 1
=i Sound Types 10 Sensor1l NullResponse 35 L Units Nl
B CMS 11 Sensorll Nul Response 59 r Virtual Inout N o
--EM5 CMS Formats 12 Sensorl2 MullResponse 95 \:"Irtual Input o e
#-d Telecoms 13 Sensori3 NullResponse 55 EI ubE; T:T m —
-3 Control 14 Sensorld Mull Response 99 E::abI‘ Flag - =
EI.__J Comfort Registers 15  Sensorl® Null Response 39 D = |.3 .ag
ﬂ]]‘ Counters 16 Sensorl Nul Response 59 Ssscngttl;:tn N
- Flags 17 Sensorl7 MullResoonse 99 o Siatus ¢

CM9001-EMS has 32 Sensor Registers that are useful for handling Sensor values
and Alarms. Sensors can be updated with various values like Temperature,
Humidity, Water Level, Current, Power, Lux etc. The sensor values can be obtained
from the MSMO01, TSMO1 or external systems like KNX, Cbus, Modbus etc.

Each Sensor is compared to a Setpoint which is held in a Counter, so that if the
sensor value exceeds the setpoint, a Virtual Input which is mapped to the sensor is

15
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activated, thus causing an alarm.

Each Sensor can be assigned to the following parameters;

+ "“Response”: Response or program that is activated when there is a change in
Sensor value. Leave as NullResponse if not needed.

* "“Counter”: The Counter Register in CM9001-EMS holds the Setpoint for the
Sensor. Changing the Counter value similarly changes the setpoint.

+ "“Max Setpoint”: Maximum Allowed Setpoint .

* “Min Setpoint”; Minimum Allowed Setpoint.

+ “Hysteresis”: Hysteresis applied when the sensor has exceeded the Setpoint
to prevent excessive switching of Virtual Input and alarm.

+ “Calibration”: Offset to the Sensor value (-128.0 to +127.0 with 0.1
resolution) to synchronise readings to a reference sensor if required.

» "“Scaling Type”: A scaling factor can be applied to the sensor value. choose
“0”, 0-99, Multiply, Divide. “0” means No scaling. "0-99” means the sensor
value of 0 to 255 is scaled to 0 to 99. Multiple and divide means the sensor
value is multiplied or divided by a Scaling value.

« "“Units” Unit text to be displayed in KPO4A in EMS Mode. This has not
function, it is only display.

« “Virtual Input”: When the Sensor Value exceeds the Setpoint (Counter
value), and the Flag is enabled, the Virtual Input is activated. See the section
on Virtual Inputs below.

+ “Enable Flag”: A Comfort Flag can be assigned to Enable or Disable the
Sensor function. A Flag is a Binary element, it has 2 values Off (0) or On (1).
CM9001 has 254 Flags numbered 1 to 254. If a Flag is assigned to the
sensor, setting the Flag (to 1) will enable the Sensor comparison, and
clearing the Flag (to 0) will disable the Sensor comparison. If the sensor is
disabled, the comparison with the counter setpoint will not take place and the
Virtual Input becomes 0 (off)

» “Description”: This is text that is displayed on the KPO4A EMS keypad.

+ "“Show Status”; Checking this box will show the real time state of the Sensor,
Counter, Flag and Virtual Input, provided the CM9001-EMS is connected (see
screenshot above). The values of Counter and Flag (but not Sensor) can be
changed by entering the value in the fields (Setpoint Value and Flag State),
which is very useful for testing as it allows changing of Setpoint and
enable/disable of the function.

The default EMS template has Counter 1 to 4 and Flags 1 to 4 assighed to Sensors
1 to 4 (Temperature, Humidity, Water Leak 1 and Water Leak 2) as shown above.

Counters

Setpoints for each sensor are kept in Counter Registers. There are 32 Counters in
CM9001-EMS which may be assigned. The Setpoint for each sensor can be set or
changed by entering a value in the corresponding Counter. If a Counter is not
assigned to a sensor that means the sensor is for monitoring only, and Virtual
Alarm and alarm will not be triggered by the sensor, and KP0O4A wiill omly show the
sensor value without setpoint. Counters are non-volatile, ie they maintain their
value even after loss of power. The Counter value may be changed in KP0O4A using
the Increment (Lock) and Decrement (Moon) keys.

16
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Flags

Flags can be assigned to a sensor. A Flag has a binary state, ie it is either On or
Off. A Flag which is assigned to a Sensor is used to enable or disables the Setpoint.
Input. In KPO4A if the sensor is monitored, pressing the SUN Key alternately
enables and Disables the Virtual Input. If disabled, the sensor is displayed only
without any setpoint. Flags are non-volatile, ie they maintain their value even after
power off.If a Flag is not assigned to the Sensor, the Setpoint is enabled.

Virtual Input

If a Virtual Input is assigned to a Sensor, it will be activated when the sensor value
exceeds the setpoint AND the Flag is enabled. Virtual Inputs can be seen in the
Zones screen eg Zones 17.18.19 Humidity” below, where the Virtual Input attribute
shows “Yes”.

Comfort | Modules Zones/Inputs &j
+-{_1 Configuration - -
=3 Mams MNo  Name Zone Type Phrase Vitual = | = Znne Pmﬂm"f_*
E Zones/Inputs 15  Zonel5 Mo IUmbEr :
% Zone Types 16 Zonel No gjme_r U;fl_:rgall 1
4y, Non-Detector / 17  HighTemperature _24HGroupNO [1]  Tempersture Area 1 Yes = ZD”E 1 ffd —TTpe P s
d{g ;’_a””l T‘-'ép‘zs 2| 18 HumidtyAreal  _24HrGroupINO [1]  Humidity Action Area 1 Yes ZD”E "".'Drd o
5 PE‘”’”ND ‘;5 19 WaterleakAreal _24HrGroupINO [1]  Water LEAK 1 Yes ZD”E ]','frd o
9 fisingiaprini 20 Waterleakfrea? _24HGroupTNO [1]  Water LEAK 2 Yes ZD”E :ﬁfrd X alure
| Statu:l Outputs B No S
: . 22 Zone2? N Virtual Input o
ﬂ- Miscellansous = 29:223 N: 0On Response | NulResponse
{7 Contiguration Fl Off Response | NulResponse
o Siren Types 24 Zone2d Mo
:i Sound T 95 Zoneds No Showr Status Mo
- Sound Types )
e 1 I M Fone?s N Duplicate EOL

Virtual Inputs can be any unused Input in CM9001 up to Input 96. A Virtual Input
need not be on the CM9001, or installed Slave or Local Expansion Modules so that
it does not use up a Physical input. The default CM9001-EMS template zones 17 to
20 are programmed as Temperature, Humidity and Water Leakage zones which can
be assigned as Virtual Inputs for the Sensors.

A Virtual Input behaves just like a physical input, ie it has a Zone Type which
triggers an Alarm Type, and activates On and Off Responses. In Alarms > Zones,
the Virtual Input setting is seen. Note that a Virtual Input will ignore anything that
is connected to the Input terminal.
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Processing of Sensors

The flowchart below will give a better idea of how the Sensors, Counters, Flags and
Virtual Inputs are processed from the sensor value to the Virtual Input and Alarm.

Sensor Processing Flow

~ i | Counter value Change
Sensor value Change

Y

Response Frocessing

Flag
= 5 o
Scaling Factor ~.. Assigned 7 -
. =) -

-~
-~ ",

J ~7 Sefpoint ™ M
< Counter
. Assigned? 7 Y

‘ Calibration

i
@

< Flagon? > No -

Yas

8]

Y

YWirtual Input On

r::j Setpaint p Y
"'-.___‘I_—_'J-'_-'_._'__E:I_'E:_E_.__E,_ ? Trigger Alarm

A . -
R Wirtual Input O '
|D al to Phones & SMS
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MSM01 PROGRAMMING
® Lm bEbL ‘ ¢

[@]RESET

1537

TPEIVE

The MSMO01 Multi-Sensor Module includes a Temperature Sensor, a Humidity
Sensor, 2 Water Leakage Cable Inputs, and 4 Digital Inputs for External equipment
failure monitoring. The MSMO1 provides the sensor values and External Input
events to CM9001-EMS Environmental Monitoring System. MSMO01 is needed only
if Sensor monitoring is required.

See the MSMO01 Installation Manual for information on installation and connections.

[ |

Select Template 2

Select the template to use as the basis for the new corfiguration.

Defaut Template |Comfort Il ULTRA -

[ Browse for template file ]

The default file for EMS does not include settings for MSM01. To load the template
for EMS with MSMO01, Go to File > New and select “"Browse for Template File”, and
select “defmsm.cctx”.

Select Sensor01 in Sensors folder in the left pane. The MSMO01 Properties can be
seen.
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G Modul
W— Sensor0l

o -_ Controller . .
EI]_] UCMs |5 Write to EEPROM | 4| Read from EEPROM | Resetto Default | Get Status
Ell_] K.E."_.fpads MSMO1 Properties | MSMO1 Sensors
e L!; = Sensor Properties
{3 DoorStations Id 1
{4 Slaves MName Sensarlll
|'__‘|.I_J Sensors Type MSMOT
b Sensorll] Version 7.001
EI‘—] SC3/RIO/IRIOs Latest Version | Unknown
o }hi Serial Mumber | Unknown
i HIOs User Comments

Click on MSM01 Sensors Tab on the top to open the screen below.
Sensor01

L ¢-__| Write to EEPROM jh__.‘ Read from EEPROM | Reset to Default | Get Status
| MSMO1 Properties | MSMO1 Sensors

Sensor Type Sensor/lnput Number  Sensor/input Name =~/ MSMOD1 Sensor Properties

Temperature Sensor 1 Sens01-Temp1 2'3"'3'“ -:—E'F':ert — '1|_-3I11|:|-3|at|_||-3 Sensor
Humidity Sensor 2 Sens02-Humid 1 .

Water Leak 1 9 Sens03-Water] Sensor/Input Mame Sens01-Temp1
Water Leak 2 4 SensD4-Water? Sensor Change Report ;

Input 1 21 MSMinput 1 _Sst:“ LET e &s

Input 2 2 MSMinput2 = riknown

Input 3 1 Sensorl

Input 4 12 Sensorl?

The menu on the top is as follows;

Write to EEPROM

Write configuration to MSMO01 internal memory. Do this when you have changed
any parameter or setting in MSM0O1

Read from EEPROM

Read from MSMO01 Internal memory. This shows the current configuration in
MSMO01 EEPROM. The file can be saved in the File menu.

Reset to Default
Reset the MSMO01 properties to default. Note that this does not write to EEPROM.

Get Status

Shows the error state of MSMO01 . The normal status should be “Normal/No Error”
which can be seen on the bottom left of the Comfigurator screen.
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MSMO01 Mapping

Temperature Sensor

Map the Internal Temperature Sensor value to a CM9001 Sensor Register. Select a
Sensor Register 0 to 31. The CM9001 Sensor register will be constantly updated
with the internal Temperature in degrees Celsius. In the default template, the
Temperature is mapped to Sensor 1 named “"Sens01-Temp1”.

Temp Sensor Change Report

This is the minimum change in temperature value before a new value is reported
by MSMO01 to CM9001. For example a value of 1 means that any change of value
>1 will be reported to CM9001. This is to reduce the number of reports to CM9001
if the number of changes is expected to be high. Set to 0 to report any change of
value.

Humidity Sensor

Map the Internal Humidity Sensor value to a CM9001 Sensor Register. Select a
Sensor Register 0 to 31. The CM9001 Sensor register will be constantly updated
with the internal Humidity in % RH. In the default template, the Humidity is
mapped to Sensor 2 named “Sens02-Humid1”.

Humidity Sensor Change Report

This is the minimum change in humidity value before a new value is reported by
MSMO01 to CM9001. For example a value of 1 means that any change of value >1
will be reported to CM9001. This is to reduce the number of reports to CM9001 if
the number of changes is expected to be high. Set to 0 to report any change of
value.

Water Leakage (1-2)

This applies to Water Leak Inputs 1 and 2.Map the Water Leakage Sensor value to
a CM9001 Sensor Register. Select a Sensor Register 0 to 31. The CM9001 Sensor
register will be constantly updated with the Water Leakage sensor value. In the
default template, Water Leak Input 1 is mapped to Sensor 3 named “Sens03-
Waterl, and Water Leak Input 2 is mapped to Sensor 4 named “"Sens04-Water2”.

Water Leak (1-2) Sensor Change Report

This is the minimum change in sensor value before a new value is reported by
MSMO01 to CM9001. For example a value of 1 means that any change of value >1
will be reported to CM9001. This is to reduce the number of reports to CM9001 if
the number of changes is expected to be high. Set to 0 to report any change of
value.

Input (1-4) Function

This applies to the 4 external Inputs 1 to 4. Select a Function for the Input; Digital,
or 0-10V
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Sensor01 f

EE"J Write to EEPRCM xi?_‘. Read from EEPROM | Reset to Default | Get Status

| MSMO1 Properties | MSMO1 Sensors

Sensor Type Sensor/Input Mumber  Sensor/Input Name = MSMO1 Sensor Properties

Temperature Sensor 1 Sens01-Temp :;P:t I1 |:
Humidity Sensor 2 Sens(Z-Humid1 = s - =
Water Leak 1 7 Cens0 Water] Sensor/Input Mumber | Unassigned

Water Leak 2 4 Sens04-Water2 gi”“;';pm Name Eu;nn}

Input 1 21 MSMinput1 =i S

Input 2 2 MSMinput2 e Sknenn

Input 3 11 Sensarll

Digital Input means the Input is a Normally Open voltage-free contact, . This is
used to connect external inputs from equipment to indicate some failure or Fault.
The Digital Input is mapped to a CM9001 Zone 1 to 96 as virtual Input.

0-10V means an analog input from 0 to 10 volts is connected to the Input. This
voltage value is mapped to a CM9001 sensor in the range 0 to 255. 0 V = sensor
value 0 and 10V = 255

Input (1 — 4) (Sensor or Virtual Input)

For Digital Input, select a CM9001 Zone/Input as Virtual Input. A Virtual Input is
like a Physical Input on CM9001 - it has Zone Type Properties, and triggers an
Alarm Type which has up to 16 phone numbers assigned for dial out. Virtual Inputs
are a powerful mechanism for activating Alarms based on sensors values. A
Zone/Input that is assigned as a Virtual Input will ignore its physical input terminal.

In the default defmsm.cctx file, MSM Inputs 1 to 4 are mapped to UPS Fail, Aircon
Fail, CRAC and FM200 respectively. These can be changed as required,

Show Status

When checked the real time values of the assigned sensors and Input registers can
be seen, as shown in the screenshot below.

Sensor01 of

EE'J Write to EEPRCM E-:fu_‘. Read from EEPROM | Reset to Default = Get Status

| MSMO1 Properties | MSMOT Sensors

Sensor Type Sensor/lnput N...  Sensor/Input Name  Status =/ MSMO1 Sensor Properties
iTemperature Sensor 1 Senz01-Temp1 5 i ;’3"';:.“ Type EI:IE:J.-_
Humidity Sensor 2 Sens02-Humid1 70 I _
Water Leak 1 9 Sens03-Water] 0 Sensor/Input Number | 12
Water Leak ? 4 Sens04-Water? 0 Sensor/Input Mame Sensorl?
Sensor Change Report | 2

Input 1 21 MSMinput 1 Off

- s Show Status Yes
Input 2 22 MSMinput2 Off - :

input 3 11 Sensorll 0 =

input 4 12 Senzoril 0
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Default Template for MSM (Defmsm.cctx)

The flowchart below graphicallly summarises the settings provided by the
defmsm.cctx file. Note that the settings can be changed as required.

EMS Counter/ EMS Flag/ EME Virtual
Setpoint Enable Input

-I Sensor | == Counter 1 '::.-I Flag 1 — _'_::-.Er'-re 17 Tre.m~.|

MISM Sensar EMS Sensor

MEM Input
Water Leak 1 | —| Sansor 3 | -I Counter 3} -I Flag 3 = Zone 19 Waler 1
Water Leak 2 | 'j::{ Sansar 4 | 1 Counter 4 .. 1 . Flag 4 _ _ Zone 20- Water 2 .,
r-.1-_“-r-_1. Input 1 | —  — _— —- Zone 21 - UPS Fail
MEM Input 2 | e  —— -| Fone 22 - gircon
MSM Input 3 = Zone 23 -CRAC

MSM Input 4 }7 -I Jore 24 - FRZOD

Sensors and Alarms

Sensor values can be obtained from the following sources;
1. MSMO01 Temperature/Humidity Sensor Module
2. TSMO1 Temperature Sensor
3. IRIO01 with ISM01 submodules with Temperature Sensor
4. External Interface by UCMs eg KNX, Cbus, Modbus

Sensor values from MSMO01 can be configured to cause Alarms in CM9001-EMS. The

MSM sensor values works with the Sensor registers in CM9001-EMS. The CM9001-
EMS Sensors screen is shown below. There are 32 Sensors numbered 0 to 31.
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o bl SemsorRespomses o

FE-{_3 Configuration
..ﬁ Alams Mo  MName Response Setpoirlt Courter Name Mz *
3 Teecons O VT || s
=3 Cortrol 1 SensDl Templ  NulResponse Ctr'[H]'I Temp1 ame . Ne'l:;‘;
K Control Menu 2 Sens02Humidl NulResponse _Ctr002-Humid1 53 S"Ef °,::’;0 ?_:t"& | D“ SPonse
Cnmr“:e'-"pad 3 SensD3Water] NulResponse _Cir003-Water] 120 ”“fm Cn”mer N“ o
= .C‘;“rieg'“m 4 Sens04Water? MNulResponse _Ctr004Water2 120 SMa"‘" o =t
_____ = Flausers 5  Sensorl5 NullResponse  Counter05 55 M_Em |I"rt 0
ﬂ Outgputs §  SensorDf MullResponse  CounterDD6 99 = H:;t : : 3
7 Senson 7 Sensorll7 NullResporise  Courter007 99 Cal_:;_“s .
_____ EI Timers 8  S5ens08Temp?  MullResponse 55 Sc:;l' ?I_n N
______ 2 X10 Transmit Code|| | @ Sens09-Humid2  NulResponse 99 oo Factr S
-3 Events 10 Sensor1l MullResponse 99 Un'rt& == Nl
£ Schedule 11 Sensorll Mull Response 55 s =
; Virtual Input Mo 255
#-{3 Functions 12 Sensorl2 Mul Response 93 Virtual |
13 Sensorl3 MulResponse 59 Enu;I r|1:|p1..|t N 255
14 Sensorld MullResponse 55 Enable Hag °
15 Sensorls MullResponse 9 = F‘_ag
Description
16 SensorlG MullResponse 59 Show Stat N
17 Sensorl?y MullResponse 55 oW StElus °

Each Sensor has a Setpoint that is mapped to a setpoint Counter, maximum and
minimum setpoint, Hysteresis, Calibration, Scaling factors, Display Units, Virtual
Inputs, Enable Flag. When the sensor exceeds the setpoint kept in the mapped
Counnter, a Virtual Input is activated which causes an Alarm. The sensor alarm can
be enabled or disabled by setting or clearing a Flag in CM9001-EMS Full details on
the Sensors Function is in the CM9001-EMS manual.

In the default template defmsm.cctx, Sensors 1 to 4 are assigned to Counters 1 to
4 for setpoints.

Water Leakage Detection

Water Leakage can be detected by connecting the Water Leakage Detection cable
WAQ01-0043 (purchased separately by meters). The WD1 and WD2 Inputs on
MSMO01 allow 2 water leakage cables to be connected, eg to the ceiling and floor
water collection trays. Map the Water Leakage Input 1 or 2 to a Sensor Register.
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Sensor01l )

'-l_} Write to EEPROM el Read from EEPROM | Reset to Default = Get Status
MSM01 Properties | MSMO1 Sensors

Sensar Type Censor/Input Number  Sensor/lnput Name  Status | [ "SH[I! Sensor mifﬂ
Temperature Sensor 1 Sens01-Temp1 :'5: ._-.L--:- - Jater Leak
Humidity Sensor 2 Sens02-Humid1 ST 1
Water Leak 1 3 Sens03-Water! EE“SD”’;PL“ “E'FTE : genﬂﬂ}-”ateﬂ
Water Leak 2 4 SensD4-Water? S:"'S':'rstatange Epo ;

Inpt 1 21 UPSFai ow Status 0

Input 2 22 AirconFail

Input 3 3 CRAC

Input 4 24 FM200

In the above screenshot Water Leak Input 1 is mapped to Sensor 3 in CM9001-EMS
and Water Leak Input 2 is mapped to Sensor 4 in CM9001-EMS

The cable in dry state has a high resistance. When the cable is wet the resistance
drops corresponding to the degree of immersion. The cable resistance is inversely
proportional to the Sensor value (0 to 255). For open circuit (Infinite resistance),
the sensor value is 0 (or close to 0). when the resistance decreases, the Sensor
value increases. A threshold can be set in the Sensors screen of CM9001 so that
when the sensor value exceeds the threshold, the assigned Virtual Input is
activated, thus triggering the associated alarm. In the default template
defmcm.cctx, the Virtual Inputs for the Water Leakage sensors Zones 19 and 20
have Zone Type O ie Disabled. If the Water Leakage detection is used set the zone
Type to 24Hr Normally Open (Zone Type 1) or as required.

For example, if the sensor value is 40 units when the cable is wet, the sensor
setpoint can be set to 20. The setpoint for water leak input 1 is in Counter 3. This
setpoint can be changed in KPO4A

Detection of Water Leakage Cable Break

It is possible to trigger a Zone Trouble alarm if the water leak detection cable is
broken or not connected. This is achieved by connecting the 100 Kohms (supplied
with the cable) at the far end of the cable. The 100K resistor is supplied connected
to the Water Detection Inputs WD1 and WD2 so that the Input does not triiger a
Zone Trouble Alarm. If the Water Detection Cable is conected, remove the 100K
resistor fron the WD1 or WD2 Inputs and connect to the end of the cable. Make
sure that the resistor with the cable does not get wet. The principle of operation is
similar to the End-of-line resistor in CM9001 Inputs/Zones, where CM9001 is able
to trigger a Zone Trouble alarm if the end of line resistors are installed and there is
a cable break. For water leak cable break detection, End of Line (EOL) resistor
(100K) is required. This is a different value from that used in the double EOL
resistors in CM9001.

With the 100K End-of-line resistor connected at the end of the dry cable, the
sensor value should be around 60 counts. If the cable is wet the sensor reading
should be 100 or more. Hence the Setpoint for water detection should be around
80 counts. The threshold for cable break should be around 30 counts (midway
between 0 and 60). To set this, go to Comfort Registers > Sensors and select the
Sensor assigned to the water leakage detector ie Sensor 3 and 3 (for WD Input 1
and 2 respectively). In Scaling Type, select “"Residual Offset”, and enter the value
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of 30 in the Scaling factor. See screenshot below. This has already been set up in
the defmsm.cctx template. Write to MSMO01, and test that when the cable is
disconnected, a Zone Trouble alarm is triggered. The Zone Trouble alarm can be
programmed to dial to any combination of the 16 phone numbers.

“omtort | Modules |

&

Sensor Responses

-3 Configuration
-0 Alams Mo  Name Response Setpoint Courter Name ~ Max Setpo * = ﬁe'-;' Response Pmpertla

m Zones/Inputs ] Sensorl0 MNullResponse  CounterD00 59 Num <l é 03 Water]

""" &l Zone Types 1 SensD1-Templ  NulFResporss _Cir001-Templ 3I} = SnsuomEter

----- 1 Non-Detector Alam Sens02-Humid1 NulResponse _CtrD02-Humid1 Respanse Name NulResponse

- Setpaint Counter No 3

‘j}' ’;f::"l:"c'f'jes EE_ Saﬁoim ot Nome | ChOB WA

i 4 Sens(4-Water?  NullResponse _CirllMd-Water2 120 - =

----- 23 Phone Mumbers Max Setpoint 120

) ) ] 5 Sensor(5 MNullResponse  CounterD05 59 : :
----- f Aming and Disami Min Setpoint 30
B Sensorl6 MNullResponse  Counter06 59 :
ﬂ SAetus Qutputs 7 Senzorl7 NullResponse  Courterl07 59 Hysteresis :
-4 Miscellaneous Sett é 5 rﬂé NulR P c rﬂl}é %9 Colibration 0
: ; rite

{77 Corfiguration Flags Enso ullResponse  Cou : -

% Siren Types 5 Sensor(l9 NullResponse  Counter}09 59 gca:m?:T;pe E;:sldual Offset

..... T8 Sound Types 10 SensorlD MullResponse  Courter010 59 | UC:e actor 0

..... B CMS 11 Sensorll NullResponse  Counter011 55 1 | :t SI ot N I:

M5 CMS Formats 12 Sensor12 NullResponse  Counter012 55 Crlnua| Input < "';at p—
-4 Telecoms 13 Sensorld MNullResponse 59 E: u':: r’1:|p N faerea 2
[#-{_4 Contral 14 Sensorl4d NullResponse 55 Er::able Flag = LFI 003 Waterl
El- I_J Comfort Registers 15 Sensorl5 NullResponse 99 2 ? .ag - agul-ivater

""" i} Counters 16 Sensorl6 MNullResponse 59 Description Water Leak 1

= I® Flags 17 Sensor1? MullResponse 99 Show Status [ N
If the cable break end of line resistor is not connected, then Scaling Type should be

Null.
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KPO4AE IN EMS MODE

KPO4A keypad firmware 7.014 and above has an alternate mode for Environmental

Monitoring used with CM9001-EMS.

The KPO4AE has the following functions for up to 4 sensors.
1. View Sensor values like Temperature and Humidity
2. View and change Setpoints
3. Enable or disable setpoints

File Edit View  Transfer

RY=1" = J5

Comfart | Modules

._ Controfler
=-C3 UCMs
-3 Keypads

“fly Keypadil
-{_J DoorStations
{1 Slaves
{1 Sensors
{3 SCS/RID/RIOs

Options  Teols  Help
@00 s HOEHNEZEM
Keypad01 b
ij Write to Keypad iJ Read from Keypad | Reset to Default
Mame Keypad 01 B
Type KPO4A
Wolume 50
Version 7.008
Latest Version Unknown
Serial Number Unknown E
User Comments
1=/ KPlx Properties
Key Beep Soft
Alert Beep Soft
Backdlight Automatic
IR Receiver Enable
Woice Broadcast Enable
Keypad Tamper Disable
Date Format DD-MM-YY
Time Format 12 Hour
LCD Contrast 7
Backlight Cff 1
= KPOD4A Properties
Marm/EMS Mode  [IEIH] [=]
Prevent Changes Alam 1
Alarm/EMS Mode
Select Alarm or EMS mode.

The KP0O4A Keypad can be in Alarm or EMS Mode. It can be changed to EMS mode
by selecting EMS in the Alarm/EMS drop-down list only if the Controller is CM9001-
EMS (not Ultra). EMS Mode is needed only for monitoring Sensors and setpoints.
There can be a combination of KP0O4As in Alarm and Sensor modes in the system.
“Prevent Changes”: if set to True, this prevents users from making any changes to
the setpoints or enable/disable settings.

In EMS mode, KPO4A can display up to 8 sensors as shown below;
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-3 DoorStations
- Slaves

- Sensors

-3 SCS/RID/RIOs
-3 HIOs

CMY9001-EMS Programming Manual

| lﬂ Write to Keypad | lﬂ Read from Keypad | Reset to Default |

LCD Contrast

Key Beep Soft
Alert Beep Soft
Bacldight Automatic
IR Receiver Enable
Woice Broadcast Enable
Keypad Tamper Disable
Date Format DD-MM-YY
Time Format 12 Hour
a7

Alam/EMS Mode

1

EMS

Frevent Changes

Falze

1

Ial Temp Sensor Mum

S

sensot-Terp1  KPO4AET Only

Sensor 1 um ’

1
Sensor 1 Mame Sens01-Temp1
Sensor 2 Mumber 3
Sensor 2 Mame Sens08-Temp2
Senzor 3 Mumber 3
Sensor 3 Mame Sens03-Waterl
Sensor 4 Mumber 9
Sensor 4 Name Sens09-Humid2
Sensor 5 Mame
Sensor & Mumber 2585
Sensor & Mame
Senzor 7 Mumber 255

Note that Internal Temperature Sensor Name is applicable for KPO4AET (with
internal Temperature sensor) only.

In the example above 4 KPO4A sensors are are assigned to Comfort Sensor

Registers.
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-3 UCMs

: o |I Keypad(
23 DoorStations
3 Slaves

[ Sensors

----- {3 SCS/RIOARIOS
i [ HIos
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KeypadO1

iﬁ] Write to Keypad iJ Read from Keypad

Reset to Default

Sensor Number:

Sensor & Mame
Sensor 7 Mumber
Sensor 7 Mame
Sensor § Mumber
Senszor 8 Mame

- Sensor 1 Properties
Sensor Mumber
Setpoint Counter Mo
Max Setpoint
Min Setpoint
Lnits
Enable Flag Mo
Enable Flag
Description

- Sensor 2 Properties
Sensor Number
Setpaint Courter Mo
Max Setpoint
Min Setpoint
Lnits
Enable Fag Mo
Enable Flag
Description

- Sensor 3 Properties
Sensor Mumber
Setpaint Courter Mo
Max Setpoint
Min Setpoint

The Sensor number selected

Setpoint Counter: The Counter assigned to hold the setpoint (in Sensors Table)

Max Setpoint:
Min Setpoint:
Units:

Enable Flag:
Description:

Maximum allowed value of the setpoint (in Sensors Table)
Minimum allowed value of the setpoint (in Sensors Table)
The Units eg degrees, %, lux, W, mW (in Sensors Table)
The Flag assigned to Enable/Disable setpoint (in Sensors)
Text 16 characters to describe the Sensor (in Sensors Table)

Note that the properties above are Read-Only, and cannot be changed in this
screen. These parameters can be changed in the CM9001-EMS Sensors Screen
described in the previous section.

If less than 8 sensors are required, leave the remainng positions empty or
unassighed. Do a “"Write to Keypad: after the sensors are selected.

KPO4AET with Temperature Sensor

KPO4AET is a variant of KPO4A which has a built-in Temperature sensor, which can
also be assigned to one of the 8 KPO4A sensors displayed in ay of the 15 KP04As in

a system.

In KPO4A Properties, “Internal Temp Sensor Name” should be assigned to a
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Comfort Sensor Register as shown below;

KeypadO1

i] Write to Keypad i] Read from Keypad | Reset to Default
Key Beep Soft
Alert Beep Soft
Backlight Automatic
IR Receiver Enable
Voice Broadcast Enable
Keypad Tamper Disable
Date Format DD-MM-YY
Time Format 12 Hour
LCD Contrast 37
Backlight Off 1

= KPD4A Properties
Alam/EMS Mode EMS
Prevent Changes Falze
Intemal Temp Sensor Number | 1
Intemal Temp Sensor Mame Sens01-Temp1 KPO4AET Dﬂ|‘_",-'
Sensor 1 Mumber 1
Sensor 1 Mame Sens(1-Temp1
Sensor 2 Number 3
Sensor 7 Name Sens3-Temn?

The Same Sensor Register can also be one of the 8 KPO4A sensor humbers which
are displayed on the LCD, as shown above. For model KPO4AE without the built-in
Temperature sensor, leave the Internal Temp Sensor Name blank of unassgined.
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KPO4AE/KPO4AET Operation (EMS Mode)

In EMS Mode, the numeric keys 0 to 9, *, # work the same way as in Alarm Mode,
ie they can be used to disarm the system or to make selections in the Voice Menu.

()

Server Temp
25 &g

0009

‘9000

The Function keys in the right column have different functions in EMS Mode
(compared to Alarm Mode) as follows;

Function Go to next Sensor. Also works as Function ~ Not affected by “Prevent
®' Key like in Alarm Mode. Changes” setting
: + + ie Increment Setpoint Disabled by “Prevent
6 Changes” setting
G - - ie Increment Setpoint
On/Off Toggle Enable/Disable Setpoint
@ * Press & Hold 4 seconds to enter setup mode

Note The * key is used to enter setup mode in both EMS and Alarm Modes.

Hence in EMS Mode, the function keys cannot be used to arm the security system
In EMS Mode, if no sensors have been assigned, then the following message will be
seen.

31



CMY9001-EMS Programming Manual

EMs Setiings
Hot. progranned! !

EMS mode is not necessary if there are no sensors to be monitored. If this message
is seen, go to Comfigurator, KPO4A and select at least 1 sensor.

If a Sensor has been assigned to the KP04A, and the CM9001 Sensors screen has
been set up (ie Sensor and Counter have been assigned) the display below will be
seen (example). The setpoint and Sensor value according to the Sensors Table is
seen. Eg the 1% sensor in KPO4A is assigned to Sensor 1, and Counter 1 as
setpoint, and the Units is degrees.

~

T

Pressing the AWAY (+) key will increment the setpoint and pressing the Night (-)
key will decrement it. The display will revert to show the Setpoint/temperature if no
buttons are pressed.

Pressing the Day key will Toggle, ie alternately disable and enable the setpoint. If
the setpoint is disabled, the Setpoint is not shown, and only the sensor value is
shown (see below). This means that there will be no sensor alarm for this sensor.

ash

If the sensor value exceeds the Setpoint, then the Virtual Input defined in the
CM9001-EMS Sensors screen is activated. Depending on the Zone Type and Alarm
Type, this can trigger an Alarm and dial or SMS to the programmed numbers for
the alarm type.

Humidity can also be displayed in one of the 4 sensor slots as shown below with or
without setpoint.
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CONTROL MENU

The default template for EMS with MSMO01, defmsm.cctx includes the settings for
the Control Menu.

‘omfort | Modules Control Menu |

F#-_d Conrfiguration
._.J Mams =- Cpntn:ul Group ' - Room 1 Monitoring » || = Control Menu tem Properties
,__J Telecoms " AT i ) = .
=3 Control = 1 - Temperature Setpoirt Phrase Waord 1 Temperaturs
B2 Cortrol Menu - 0- Seipo?rrt+ Phrase Word 2
' - 1- Setpoirt- Phrase Word 3
2- Phrase Word 4
i' Altemative Phrase
5 ) Feedback Type Sensor
ne Feedback Mame @ Sens01-Templ
EI - Show Status [ Mo
Timers o E
b Ly %10 Transmit Code 8-
B0 Everts .5
-3 Schedule oo
-3 Functions - 2 - Humidity
= 3 - Humidity Setpoint
- 0 - Humidity Setpoirt+ Control Menu ftem Properties
-1 - Humidity Setpoirt- Select a Feedback Type to determine how
- 2 - status of the appliance is announced ar
T displayed. f Feedback Type is Zone, Outp
e Hag, the action keys 0 and 1 are automati
assigned to words "0 and "On" respecti
8- For Feedback Type = Flag or Output, Actic
- - lkeys 0 and 1 automatically set and clearth
T assigned Flag or Output without having to
B assign responses. However f Responses
g assigned to action keys 0 and 1, then the
N B automatic flag or output actions do not apg
- 4 - Water LEAK 1 Lewvel For Zones, action keys 0 and 1 do not hay
foin default actions so Responses are needed:

The control menu allows the Temperature, Humidity and Water Level sensors
values to be monitored, and the Temperature and Humidity Setpoints to be
monitored and changed.

The Control menu can be accessed by Keypad, Telephone Call, SMS or iOS/Android
apps.
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IOS/ANDROID APPS

The default control menu allows the current temperature, temperature setpoint,
current humidity, humidity setpoint, Water Leakage sensor 1 and 2 levels to be
viewed via the Cytech iOS or Android apps, and also allows the setpoints to be
changed as shown in the screenshot below (i0S)

Close CONTROL

Room 1 Monitoring
¥ Temperature

9 Temperature Setpoint

Temperature Setpoint

¥ Humidity

& Humidity Setpoint 5 { Setpoint+

Water LEAK 1

‘% Water LEAK 2

Setpoint-
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SMS MONITORING

» Acts as a backup for alarm dialout when the land line is faulty or cut, or can be used
as the primary dialler without a fixed telephone line, for installations where a
telephone line is not available.

» Allows the user to dial to the GSM number instead of the fixed telephone line to
access Voice menus.

+ Allows CM9001-EMS to report alarms to the users mobile phones via SMS. The SMS
message will show time stamp, Alarm type and Zone (Input) Name.

* Allows authorised Mobile phones to send SMS commands to control or check the
status of Inputs, Temperature, Humidity or other sensors.

Refer to the UCM/GSM4 Manual (download from http://www.cytech.biz/ucmg
sm_manual.html ) for installlation and programming of UCM/GSM4.

The SMS format to send to CM9001-EMS to see the sensor values and setpoints
depends on the Control menu programmmed in CM9001-EMS

Alarm Messages are sent by SMS as show below

16:12 Cytech- Alarm
Group1-002
Temperature

16:12 Cytech- Alarm
Group1-005 Humidity

16:12 Cytech- Alarm
Group1-005 Humidity-
Restore

16:12 Cytech- Alarm
Group1-002
Temperature-Restore

Users can send SMS messages to CM9001 to query the sensor values and setpoints
and to change the setpoints as shown below
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Room 1 Monitoring
> Temperature
> 021.

(400) - Temperature

® O |

Room 1 Monitoring
> Temperature Setpoint
> 025.

(401) - Temperature
Setpoint

£ A ~A A ~ .

Room 1 Monitoring
> Humidity
> 064.

(402) - Humidity

37

Room 1 Monitoring

> Temperature Setpoint

> 024.

(401) - Temperature

Setpoint
(4010) - Set -
(4011) - Set +

Room 1 Monitoring
> Humidity Setpoint
> 069.

(403) - Humidity
Setpoint

(4030) - Set -
(4031) - Set +
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Room 1 Monitoring
> Water LEAK 1 Level
> 064.

(404) - Water LEAK 1
Level
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GRAPHICAL SENSOR DISPLAY

The optional UCM/Pi (Raspberry Pi Interface) allows graphical display of up to 32
sensor values over time on mobile phone or computer as shown in the example
below.

Temperature A | B | , C .
_|Date Temperature |Humidity
3 | si4/2019 8:43 28 53
30.5 | 54/2019 8:43 28 53
- Su 08:39 | 54/2019 843 28 53
:30 | 54/2019 8:43 28 53
29.5 | 5/4/2019 8:43 28 53
2o | 54/2019 8:45 28 53
1 54/2019 8:45 28 53
28.5 1 54/2019 8:45 28 53
28 1 54/2019 8:45 28 53
| 54/2019 8:45 28 55
275 | 512019 8:45 28 53
27 1 5/4/2019 8:45 28 55
Fr 16:00 Sa 04:00 Sa 16:00 Su 12:00 54442019 8-46 28 53
| 54/2019 8:46 28 55
- 5/4/2019 8:46 27 55
Humidity 1 542019 8:47 28 55
66 | 542019 847 27 55
o4 1 542019 8:47 28 55
1 542019 8:47 P, 55
62 | 5/4/2019 8:48 28 55
| 54/2019 8:48 27 55
60 1 54/2019 8:49 28 55
58 | 5/4/2019 8:49 27 55
£/4/2019 850 28 55
56
54
52
Fr16:00 Sa 04:00 Sa 16:00 Su 12:00

This can also be configured to send daily (or at other interval) emails with sensor
values in .csv format. The recording intervals can be configured eg 5 minutes, 1
hour etc.

Document History

» 27 February 2018 Initial release

* 10 June 2018 Added KP04A, UCM/GSM4

e 17 July 2018 added MSM01

+ 20 May 2019 - added UCM/Pi Graphical Sensor display, KPO4AT
5 Sept 2019 - Added KPO4AET, 8 sensors Display
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